
www.augiworld.com US $8.00

Also in This Issue 

• AutoCAD for 3D Modeling 
and Visualization

• Expanding on Details in 
3ds Max

• Tech Manager Show 
and Tell

September 2017

AUGIWorld
T h e  O f f i c i a l  P u b l i c a t i o n  o f  A u t o d e s k  U s e r  G r o u p  I n t e r n a t i o n a l

Diamond Sponsors 

Salary
Survey

16th
Annual

AUGI

http://www.augiworld.com


The next giant leap for humankind. We invite  
you to imagine, create, and virtually experience  

a sophisticated civilization on Mars. A new  
home for one million humans.

R E I N V E N T  L I F E  O N  M A R S

J O I N  N O W
hp.com/go/mars

* First 10,000 people to register will receive access to the Fusion Mars 2030 VR game

Image includes: Biosphere 2 at the University of Arizona

© 2017 HP Development Company, L.P. NVIDIA and Quadro are trademarks and/or registered trademarks of NVIDIA Corporation in the U.S and other countries. All other trademarks are the property of their respective owners.

P O W E R E D  B Y

http://hp.com/go/mars


AUGIWorld SE
P

T
E

M
B

E
R

 2017

contents
product focus

16

September 2017 www.augi.com  3

4 Letter from the President

14 CAD Manager

24 Inside Track

26 Tech Insights

14

columns

30

6 AutoCAD 
AutoCAD for 3D Modeling and Visualization

10 Revit Structure 
Customizing the Graphical Column 
Schedule

16 InfraWorks, Civil 3D and Civil View 
A Civil View from Your Seat

28 3ds Max 
Expanding on Details

30 AutoCAD Architecture 
AEC Wall Objects

34

34 16th Annual AUGI Salary Survey

special feature



Letter from the President

4 www.augi.com September 2017

SE
P

T
E

M
B

E
R

 2
01

7

www.augiworld.com

Editors
Editor-in-Chief
David Harrington - david.harrington@augi.com

Copy Editor
Marilyn Law - marilyn.law@augi.com

Layout Editor
Debby Gwaltney - debby.gwaltney@augi.com

Content Managers  
3ds Max - Brian Chapman
AutoCAD - Walt Sparling
AutoCAD Architecture - Melinda Heavrin
AutoCAD Civil 3D - Shawn Herring
AutoCAD MEP - William Campbell
BIM Construction - Kenny Eastman
CAD Manager - Mark Kiker
Inside Track - Brian Andresen
Inventor
Revit Architecture - Jay Zallan
Revit MEP - Joel Londenberg
Revit Structure -Jason Lush

Advertising / Reprint Sales
Kevin Merritt - salesmanager@augi.com

AUGI Executive Team 
President 
Kate Morrical

Vice President 
Scott Wilcox

Treasurer
Robert Green

Secretary
Chris Lindner

AUGI Management Team
Kevin Merritt - Director of Communications
July Ratley - Director of Finance
David Harrington - Director of Operations

AUGI Board of Directors
Robert Green
Kimberly Fuhrman 
Chris Lindner

Curt Moreno
Kate Morrical
Scott Wilcox

Publication Information
AUGIWorld magazine is a benefit of specific AUGI 
membership plans. Direct magazine subscriptions 
are not available. Please visit http://www.augi.com/
account/register to join or upgrade your membership 
to receive AUGIWorld magazine in print. To manage 
your AUGI membership and address, please visit 
http://www.augi.com/account . For all other magazine 
inquires please contact augiworld@augi.com

Published by: 
AUGIWorld is published by Autodesk User Group Inter-
national, Inc. AUGI makes no warranty for the use of its 
products and assumes no responsibility for any errors 
which may appear in this publication nor does it make a 
commitment to update the information contained herein. 

AUGIWorld is Copyright ©2015 AUGI. No informa-
tion in this magazine may be reproduced without 
expressed written permission from AUGI.

All registered trademarks and trademarks included in this 
magazine are held by their respective companies. Every 
attempt was made to include all trademarks and regis-
tered trademarks where indicated by their companies.

AUGIWorld (San Francisco, Calif.)
ISSN 2163-7547

I
t’s September, which means it’s back-to-school time! As a kid, I always 
hated to see summer go, but shopping for school supplies was some 
consolation. Even today, I find myself craving fresh new pencils, crisp 
notebooks, three-ring binders...never mind that I rarely use those things 

anymore! The fact that we’ve gone digital just makes the nostalgia stronger.

It’s not only the sales on crayons and safety scissors that made me choose to write about 
education for this month’s letter. AUGI is focused on two big events right now that tie 
back into that theme: the Salary Survey and Autodesk University 2017.

The results of the 16th Annual Salary Survey are published in this month’s AUGIWorld. 
Once again, Melanie Perry has collected data from thousands of design professionals 
just like you and turned it into a fascinating picture of compensation trends across a 
variety of demographics, including education level, job title, and firm size. If you’ve ever 
wondered how your job stacks up against those of your peers, here’s your chance to find 
out. And if you’ve used the Salary Survey before to see where you stand, it’s a great op-
portunity for a status check, to see what has changed from year to year.

It might be a bit of a stretch to call the Salary Survey “education,” but I think I can make 
a case for it. One definition of education is “the acquisition of knowledge,” and learning 
how your salary compares to that of people in similar jobs certainly qualifies! By educat-
ing yourself on the state of the industry, you gain an understanding of your own value. 
Then you can begin to make a plan: either to educate your boss about why you deserve a 
raise or to educate yourself to gain new skills and earn that raise!

If you fall into the latter camp, Autodesk University is a great place to start. This year’s 
event in Las Vegas has something for everybody. Whether you are just beginning to 
learn a new program, are trying to develop your management skills to advance at your 
firm, or want to see what cutting-edge advancements are happening in your industry, AU 
can help you find what you need. The classes I take each year are always different, yet 
somehow they’ve always been what I was looking for.

If a trip to Las Vegas (or one of the international AU events) isn’t in the cards this year, 
consider online learning. Browse the AUGIWorld archives for invaluable nuggets of in-
formation, or take a deeper dive into topics with recorded conference sessions from AU 
Online—much of it provided by instructors who are also AUGI members!

Speaking of AU, have you looked at the AUGI Wish Lists lately? Now would be an 
excellent time to peruse the current wishes to see if there are any you would like to rank 
or buy (with your virtual Wish Cash) to help us generate this year’s Top 10 lists, which 
will again be presented to Autodesk at AU 2017.

Like the Salary Survey, the Wish Lists depend on your participation. Every member’s con-
tribution improves our results. There are over 400,000 of us worldwide—what power our 
voices could have! Imagine if every AUGI member logged in and voted for their top 10 wish-
es. That would be four million wishes for the products you use every day. Pretty impressive!

So, login to AUGI.com today. Vote for wishes. Educate us on what you want. We might 
all learn something!

Kate Morrical
AUGI President
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AutoCAD for 3D 
Modeling and 
Visualization

A
bout three quarters of the world’s popula-
tion are visual learners. This fact highlights 
the importance of quality visuals when 
communicating ideas. Clear images can be 

more accurately interpreted and lead to project success. 
Our ability to communicate in the AEC industry currently depends 
on the right software and modeling tools and how to get the most 
out of them. Better options for visualization have been exponentially 
improved due to advances in reality capture, GPU/CPU capacity, and 
rendering quality. There are many tools available for 3D modeling and 
visualization but some of the best tools are just within reach—that is, 
they are available in recent versions of AutoCAD®. Tools for work-
ing with point clouds, solid modeling, and internal renderings within 
AutoCAD have been forgotten in the shuffle, but still provide value 
due to their availability. Let’s uncover what they can do.

WORKING WITH POINT CLOUDS

As sensors get cheaper, the number of construction projects using la-
ser scanners increases, especially when dealing with renovation work. 
These sensors are capable of collecting millions of points with milli-
metric accuracy, representing existing conditions in a scene. AutoCAD 

has your back if you want to visualize and interact with point clouds. 

Under the Insert tab is the Point Cloud tools panel (see Figure 1). 
The first tool launches Autodesk® ReCap™, which is used to index, 
create, or edit point cloud project files. The second icon allows you to 
attach ReCap files (.rcp or .rcs only). If your point clouds are saved 
in a different file format, ReCap can convert those for you from the 
most generic content (.txt, .las, .laz) to the most specific laser scan-
ning brands (Faro, Leica, Topcon, Riegl, DotProduct, and more).

Once the file is inserted, there is another set of tools you can use to 
interact with your point cloud (see Figure 2). Even with Autodesk’s 
improvements to develop better tools and faster rendering of point 
clouds, these files are usually going to be large datasets that could 
create performance issues. In this case, your best friend could be 
the toolbar where you can control information related to Display/
Visualization and Cropping. For example, the Level of Detail de-
termines the number of 3D points shown on the screen. This is a 
huge help when you notice your computing performance starting to 
decline. The other handy tool that could save the day is Cropping. If 
you know you only need to partially visualize or model from part of 
the point cloud, you could save a ton of time by just turning off the 
points that are not going to be needed. 

Figure 2: The point cloud toolbar

Figure 1: Inserting the point cloud file
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On the modeling aspect of point clouds, there are also commands to ex-
tract edges, corners, or centerlines of cylinders based on groups of points 
(see Figure 3). This is a big timesaver to find and model wall edges, 
openings, or pipes. This is part of the effort of creating smarter point 
clouds. There’s huge interest in algorithms for point cloud segmentation 
in the research community, and there’s plenty of room for improvement. 

Figure 3: Extracting geometry from point clouds

ADDING CONTEXT TO VISUALIZATION

Creating a mixture of content from different source types can 
enrich our models and make the process more flexible depend-
ing on the desired outcome. AutoCAD has features that provide 
more options while creating models such as interacting with 3D 
solids, 3D surfaces, and 3D meshes (see Figure 4). Some of these 
elements are more efficient to work with and others require more 
computing power; however, they complement each other, provid-
ing a variety of modeling features for the task at hand. 

Figure 4: 3D element formats: solid, surface, and mesh (Source: knowledge.
autodesk.com)

Combining reality capture with native AutoCAD elements, we are 
able to create models that give us more detailed information about 
the ideas we want to communicate. Figure 5 shows a point cloud in 
the middle of masses representing structures in a small area of an 
urban neighborhood.

The 3D solids help to give the context of the surroundings to plan 
and make better assumptions on this and similar projects.

Figure 5: Modeling 3d solids to create context

Recently, UAVs (drones) have been used more widely for commer-
cial purposes. This increase in usage yields higher quality data that 
can be used to share with other stakeholders. Figure 6 shows build-
ing masses created from tracing building footprints and converted 
into solids using extrusion tools. Notice that the underlying image is 
a processed orthomosaic whose planimetry (i.e., not skewed) is ac-
curate, compared to raw aerial images taken directly from a camera.

 

 

Figure 6: Building footprint tracing 

http://www.augiworld.com
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REALISTIC VISUALIZATION

So far, we have covered visualization and modeling from a concep-
tual point of view. However, there is a point in the design process 
when we want to get realistic output. AutoCAD provides a library 
of realistic materials to enrich your renderings (see Figure 7). If the 
project requires custom textures, they can be incorporated as well. 
However, if the files are opened on a different computer, you will 
lose bitmaps if they’re not transferred. 

Figure 7: Realistic render

As a rule of thumb, initial renderings should be processed in low 
quality using a setting in the Render Presets Manager (see Figure 
8) so that time is not wasted during tuning of minor details (i.e., 
lights, materials, and camera position.  

Figure 8: Render Presets Manager

Now you can share your projects using A360 (Figure 9) and be 
able to reach a larger audience that doesn’t use AutoCAD, just a 
web browser. It is possible to create multiple predefined views or 
the user can orbit the model. On the negative side, there are some 
issues with the conversion of materials, as we see on the cylinder 
below. In addition to that, custom textures will not show in the 
A360 viewer.

Figure 9: A360 viewer

In conclusion, if we want to encourage the use of a richer form of commu-
nication without jumping through endless software hoops, AutoCAD’s 
wealth of 3D tools is the answer. Or just add this to your repertoire of 
tools to improve the visualization of your output. We want to stress the 
different options that may be available. For instance, if you do not have 
access to a laser scanner, there are cheaper solutions by using drones and 
photogrammetry. And if you do not have a rendering machine, you could 
also rent a powerful virtual machine online to render in the background 
while you keep producing. In this day and age, there’s no excuse for not 
impressing your clients with powerful and contextualized output.

Xavier Loayza started using CAD soft-
ware during high school. These drafting 
skills boosted him to collaborate very early 
in the AEC world to later pursue a path to 
civil engineering in Ecuador. After gaining 
experience over the years in transportation, 
geotechnical engineering, and surveying, 
Xavier got interested in UAVs (drones) for 
mapping, construction monitoring, and 
urban planning as a time and cost effective 
tool, leading him to establish a service com-
pany. In 2015, after this entrepreneurial 
project, Xavier joined a Construction Man-
agement graduate program at University of 
Houston. Currently, he is collaborating with 
Axoscape, a BIM consulting company. He 
is always eager to learn and share.
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by: Jason Boehning and Marcello Sgambelluri

T
he structural tools in Autodesk® Revit® 
have some quirks not found within the oth-
er disciplines in Revit. One of those is the 
graphical column schedule. You can create a 

graphical column schedule from the View ribbon, in 
the Schedules drop-down, but it will appear under Views in the 
Project Browser instead of in Schedules/Quantities. And typically, 
model elements do not appear in schedules, but actual columns do 
appear in graphical column schedules. Therefore, graphical column 
schedules really are unique.

Structural columns are identified in graphical column schedules by 
intersecting grid lines and by their top and bottom constraints and 
offsets. Architectural columns do not display in these schedules, 
nor do any other model elements, for that matter. The columns in 
these schedules are viewed from the south.

Graphical column schedules are system families in Revit and have 
instance and type parameters. Typically, there is not a great deal of 
customization with system families in Revit. However, graphical 
column schedules are unique, and there are several methods you 

Customizing 
the Graphical 
Column 
Schedule

can use to customize them to fit the needs of your project. For ex-
ample, you can control which levels and structural columns appear, 
you can adjust the size of rows and columns, you can adjust the 
appearance of the grid lines and text, and you can add symbols for 
column splices and baseplates. Oh, and you can tag the columns 
inside the schedule. So yeah, graphical column schedules do not 
behave like other schedules at all!

CONTROLLING LEVELS

One of the first things you should do with a graphical column 
schedule is adjust the levels shown. Often in a building proj-
ect, several levels are created for the various needs of the proj-
ect. However, it is likely that not all of them need to be shown 
in the graphical columns schedule. When a graphical column 
schedule is the active view, the instance properties appear in the 
Properties palette.

To control the levels, scroll down to the Other grouping. Here, 
you can set the Top Level and the Bottom Level. The default levels 
used are the highest and lowest, respectively (see Figure 1).
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Figure 1

To control the levels that are visible in the graphical column 
schedule, click Edit… next to Hidden Levels. This opens the Levels 
Hidden in Graphical Column Schedules dialog. So technically, 
you are specifying the levels that are hidden. To hide a level from 
the schedule, simply select it in the list.

REMOVING COLUMNS

In addition to having unwanted levels in a graphical column 
schedule, you may have unwanted columns as well. To take care 
of these, simply select them and hide them in the view. You can 
select columns in a graphical column schedule the same way you 
can in an elevation or section view. Then, once the columns you 
want to hide are selected, right-click and select Hide in View > 
Elements (see Figure 2).

Figure 2

SHOWING OFF-GRID COLUMNS

To include off-grid columns in the graphical column sched-
ule, simply select Include Off-Grid Columns in the Prop-
erties palette. Then you can control the Off-Grid Units 
Format. This is important because the column locations for 
off-grid columns will display with the distance to the nearest 
grid (see Figure 3).

Figure 3

ADJUSTING ROW AND COLUMN SIZES

To adjust the width and height of rows and columns, you need 
to open the Graphical Column Schedule Properties dialog. 
The sizes cannot be adjusted by dragging the grid lines in a 
graphical column schedule. In the Properties palette, click 
Edit… next to Grid Appearance to open this dialog. On the 
Grid Appearance tab, there are two areas: Horizontal Widths 
and Vertical Heights.

In the Horizontal Widths area, you can control the width for the 
columns containing the structural columns (For Column Loca-
tions:) as well as the width for the column containing the level 
names (For Level Names:).

In the Vertical Heights area, you can control the row height 
for the row above the top level (Above Top Level:) and the row 
below the bottom level (Below Bottom Level:). You can also 
specify the distance between schedule segments (Between Seg-
ments:) for instances where there are multiple segments in the 
schedule (see Figure 4).

http://www.augiworld.com
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Figure 4

ADJUSTING THE LINE STYLE OF GRID 
LINES

There are no instance parameters for graphical column schedules to 
control the line style of the grid lines. These lines are controlled by the 
Thin Lines style in Revit. This line style is controlled in the Lines Styles 
dialog for the entire Revit project. In other words, if you modify the style 
in the Line Styles dialog, it will update everywhere that line style is used.

To adjust the line style for just the graphical column schedule grid 
lines, you can open the Visibility/Graphic Overrides dialog for the 
view. Then on the Model Categories tab, expand the Lines catego-
ry and adjust the settings for Thin Lines. You can control the line 
weight, line color, and line pattern.

CONTROLLING TEXT APPEARANCE

In the Properties palette, click Edit… next to Text Appearance. 
This opens the Graphical Column Schedule Properties dialog 
to the Text Appearance tab. Here, you can control the Title text, 

Level text, and the text used for the Column Location. You can 
specify the text font, size, and additional text attributes, such as 
Bold, Italic, and Underline (see Figure 5).

Figure 5

ADDING ANNOTATION SYMBOLS FOR 
SPLICES

You can use annotation symbols to show splices in graphical 
column schedules. The process is similar to the method of 
showing structural framing symbols in a plan view. Essentially, the 
connection symbols created in the Structural Settings dialog will 
be available for selection for the structural column parameters.

In the Structural Settings dialog, there is a Connection Symbols 
area. When you expand the “Display Symbols for:” drop-down, 
you can select Beams and Braces, Column Base, or Column Top. 
Depending on the situation and symbols you use, you can create a 
connection symbol for both, or just one end. With the desired end 
selected in the drop-down, click New. This opens the New Con-
nection Type dialog. Enter an appropriate name for the Connection 
Type: and then you can select a loaded connection symbol family in 
the “Annotation Symbol:” drop-down (see Figure 6).

Figure 6
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Jason Boehning is the Building 
Content Manager for all BIM 
and architectural CADLearning 
products from 4D Technologies, 
driving BIM content and developing 
on-demand learning material for 
Autodesk software, including Revit 
and Dynamo. He is also a repeat 
speaker at RTC North America and 
Autodesk University. 

Marcello Sgambelluri currently serves 
as the Building Information Modeling 
(BIM) director at John A. Martin & 
Associates Structural Engineers in Los 
Angeles, California. He has worked 
on many BIM projects over the last 
18 years as a project manager, design 
engineer, and BIM director.

As a side note, you can create your own connection symbol 
families, if needed. An easy way is to start with the Generic 
Annotation family template and then change the Family Category 
to Connection Symbols.

Once you have connection symbols created in the Structural 
Settings dialog, you can select them for either the Top Connection 
or Base Connection parameter for structural columns. Take note 
that these are instance parameters for columns (see Figure 7).

Figure 7

Finally, you can control the distance between the columns in the 
Structural Settings dialog in the Symbolic Cutback Distance area 
(see Figure 8).

Figure 8

ADDING INFORMATION

You can add text, tags, keynotes, spot elevations, spot coordinates, 
and spot slopes to graphical column schedules. While all of these 
are great methods to add information (except non-parametric 
text), tags are really a great way to add customization to a graphical 
column schedule. You can use shared parameters to create column 
families, and then add those shared parameters to labels in tags.

A great example is adding baseplate information to a graphical col-
umn schedule. You can create an extrusion in a column family to 
represent a baseplate. Make sure to use reference planes to control 
the extrusion geometry, and then dimension the reference planes. 
After that, you can assign a shared parameter to the dimension so 
the parameter will drive the dimension. Lastly, add the same shared 
parameter to a label in a tag family. Then you can tag the column 
in the graphical column schedule and have the information display.

Along those lines, you can add shared parameters to the column 
families to input information such as the number of bolts and bolt 
diameter. These parameters would not be associated with any ge-
ometry. You could then add them to tags to display this additional 
information in the graphical column schedule.

CONCLUSION

If you use graphical column schedules in your projects, you 
should spend some time going through these methods to cus-
tomize your schedules. It is important that the correct informa-
tion is displayed, and that it is displayed the way you want. These 
methods can help you achieve both! And, on a final note, once 
you have the graphical column schedules configured the way you 
want, save it as a view template.

http://www.augiworld.com
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W
ay back in November 2006 I wrote 
an article for AUGIWorld about the 
need for CAD Managers to make sure 
they do not become invisible to their 

firms. I referenced a saying that I have used over the 
years to put it all into perspective…

“When I am doing my job right, I become invisible.”

I then reviewed the good and bad impact of becoming invisible.  I 
recently discussed this with a colleague and it reminded me of what 
I wrote. This article will build on that one. You can go back and read 
that one if you have access to old issues (a perk of advanced AUGI 
memberships). In a nutshell, when things are going good and your 
environment is humming, it appears that the CAD Manager does 
not exist. You need to make sure that people know you are there. You 
need to do a little of what you did in kindergarten...

SHOW AND TELL

In early childhood, everyone was encouraged to bring something 
to school for “Show and Tell.” In what may have been their first 
experience in public speaking, each little student would stand in 
front of the classroom and share something with fellow classmates. 
They would hold an object and talk about it. 

Tech 
Manager 

Show
and
Tell

For some, this exercise was the chance to gather all eyes and ears on them 
and they loved it. For others, it was torture to have everyone looking at 
them and listening to every word they said. I am not sure where you fell 
in that continuum, but everyone had to participate.

You should continue to participate today. After reviewing the AUGI 
Salary Survey in this issue, you may be elated or depressed. You are ei-
ther ahead of the crowd or maybe behind it. By showing your stuff and 
telling others about your accomplishments, you stand a better chance of 
increasing that salary.

I am encouraging you to continue to Show and Tell at work. Not by 
standing in front of the room and holding up your coffee mug and tell-
ing everyone that you got it for Father’s or Mother’s Day, but by show-
ing others what you can do and then telling them what you have done.

In a classic “Calvin and Hobbes” cartoon strip, Calvin is at school 
during Show and Tell. He is standing in front of the room and says, 
“Today for Show and Tell, I refuse to show you what I brought and I 
refuse to tell you anything about it.” Needless to say, he did not do well 
and ended up going to the principal’s office. Do not follow his lead. 

SHOW IT

Most Tech Managers got where they are by showing that they have the 
savvy to make more progress than others. They are more productive. 

http://www.augi.com
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They manage well. They are at the top of their tech game. They are plan-
ning and executing with vigor. They are getting so much done. They are 
impressing their peers and management with the knowledge they have. 
They are doing a great job of showing that they have what it takes. 

When asked if something is possible, Tech Managers roll up their 
sleeves and jump in. They are determined to prove their worth by 
action. What a great attitude. They don’t make promises unless they 
know they can keep them. They back up their words with work. 
They dig in and figure out the answer to tech troubles. They dem-
onstrate the software, train the staff, and take charge when problems 
come along. When their solution is challenged, they prove it works. 
They may say, “Words are nothing, actions are everything.”

“Isn’t that what it takes?” they ask. “Getting things done is more 
important than talking about it,” they continue. This is very true. 
If you are all talk and no action, then people will soon lose interest 
and go find someone who can get things done. 

You must get things done. This is the Show part. Show me what you 
can do—don’t tell me. If you have nothing to show for all the effort 
you put in, then your salary will not reflect the value you bring. You 
have to show what you know. But you cannot stop there. People will 
be impressed, but may soon say, “What have you done for me lately?”

TELL IT

You have to tell people what you are doing and what you have 
done. Most people are too busy to notice what you are doing. They 
are too busy trying to get their own jobs done and may not even see 
what you bring to the table. If they do not see your actions, then 
they certainly will not remember what you have done for them in 
the past. You have to tell them.

Take the time to tell people what you are up to. “I don’t know how 
to put this… but I’m kind of a big deal” - Ron Burgundy. You may 
not want to come off like the Anchorman, but you do need to 
speak up. It is so ingrained in us not to brag that we fail to men-
tion what we have accomplished. We need to remind others of our 
contributions, with humility and at the appropriate time. When 
you do, there are some things to keep in mind:

Do it at the right time

Don’t just walk up to a group and spout off about what you just achieved. 
They may not care or even worse, they may be offended. Bring up your 
efforts when the topic moves to an area where you contributed. You may 
make it a question: “Did the tip I provided help?” They then know there 
was a tip or trick and that you provided it. They may give you positive 
feedback and thanks (they recall and recognize what you did) or they 
may tell you that it did not (allowing you to “show” them some other tip).

Don’t compare yourself to others

Saying that you completed the project on time or early is fine. Saying 
that you completed the project faster than others (and using their 

Mark Kiker has more than 25 years 
of hands-on experience with technol-
ogy. He is fully versed in every area of 
management from deployment plan-
ning, installation, and configuration 
to training and strategic planning.     
As an internationally known speaker 
and writer, he is a returning speaker 
at Autodesk University since 1996. 
Mark is currently serving as Direc-
tor of IT for SIATech, a non-profit 
public charter high school focused on 
dropout recovery. He maintains two 
blog sites, www.caddmanager.com and  
www.bimmanager.com .

name) is not. Comparing yourself to others is not well received. 
Don’t put others down, either. Don’t preface your comments with, 
“You know that problem that no one could fix? I fixed it.”

Tell a story

Couch your accomplishments in the middle of a story that includes 
others. The team did a great job and you contributed “this piece.” 
Bring up your part in the successful efforts only in moderation. 
Don’t blow that horn too long or too loud.

Be brief

Don’t go on and on about what you did. Keep it short and to the 
point. If no one comments, just move on. If they ask questions, ex-
pound a little more and then stop. Too often we are tempted to go 
on about some milestone we hit or a problem we fixed. Just drop a 
line or two and let the words do the work. People will register what 
you said and take notice over time. Don’t push it.

Keep a list

I have come across many Tech Managers who cannot quickly 
show me what they have done in the last few months or year. 
They are extremely busy and effective, but they may not have 
anything to “show” for it. It wasn't that they didn’t accomplish 
anything, but that they do not recall what it was. They are so fo-
cused on the present that they forget the past. They are shocked 
when others do not recall or notice what they have done.  Make 
a list in your head, digital, or on paper. Reviewing it yourself 
will bolster your confidence and give you reminders on what you 
might share when the time is right. 

So going forward, make a list of the things you have done in the 
past few months or year and start dropping things into conversa-
tion. It takes practice to know what to share and how to share it. 
Just keep practicing your show and tell skills.

http://www.augiworld.com
http://www.augiworld.com
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D
uring the “suites” era, many compa-
nies upgraded from a single license of 
Autodesk® Civil 3D® or another verti-
cal product because the upgrade was 

offered for free. However, not many used the 
products offered in the suites.

Now that 2016 has come and gone (and so have the suites) we 
have the Autodesk Collections. These Collections offer much 
more than the suites did.

This article will take you through a workflow for using your collec-
tion (or suite), to bring your Civil project from a bland, 2D visual 
to a realistic 3D animated model. You will need a good under-
standing of InfraWorks® and Civil 3D to follow these instructions.

A Civil View 
from Your Seat

The software used for this workflow is Civil 3D, InfraWorks, and 
Civil View, which is a plug-in inside of 3ds Max®. You don’t have 
to be a 3ds Max expert to do this. In fact, you don’t need to know 
how to use 3ds Max at all.

STARTING IN INFRAWORKS

This year, InfraWorks 360 was rebranded to drop the “360” and is 
now simply InfraWorks. With all the new features housed within 
InfraWorks, you can do 40 to 50 percent of your design work be-
fore you even open Civil 3D. 

First, you will start by creating a Design Road in InfraWorks. 
You can lay out your horizontal road design using AASHTO 
(American Association of State Highway and Transportation) 
standards. You can then edit the vertical alignment by going to 
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the Profile View under the Design, Review and Engineer Roads 
button, then clicking the Review and Modify Road Designs button.

Figure 1

If you are satisfied with how the road looks horizontally and 
vertically, you can then export it out as an IMX file. You will select 
the area you want to export by polygon or box selection. Make sure 
you have a target coordinate system set before you click the Export 
button. This file will be the base for more precise tweaking and 
corridor creation within Civil 3D.

TWEAKING AND PREPPING IN CIVIL 3D

Open Civil 3D and start a new drawing. Make sure you do 
NOT have a coordinate system set. If you are using a template 
file with a coordinate system set in it, then go to the Drawing 
Settings and replace the coordinate system code with a period 
(.). When you import the IMX file, you will be prompted to 
assign a coordinate system. 

In the 2018 version of Civil 3D, the InfraWorks importation has 
been revamped. The previous way to import was from the Insert 
tab, clicking on InfraWorks 360 and then opening InfraWorks 360 
Model. Now there is a tab exclusively for InfraWorks. 

Click Open Model. There is also an option in 2018 to Import 
IMX, but I recommend using the Open Model option. The dif-
ference between the two options is that with the Open Model op-
tion, you can pick and choose what to import into Civil 3D (roads, 
water areas, coverage areas, etc.). The Import IMX option does 

not give you any choices—it simply imports everything from the 
IMX file.

Design roads automatically create an alignment and have a profile 
associated with it. The profile view, once created, will show several 
vertical alignments:

• The proposed vertical alignment will be a random number 
assigned from InfraWorks (mine is 14)

• AIW_Existing_Ground

• AIW_Existing_Transportation

• AIW_Proposed_Ground

Now you will create a corridor from the design road’s horizontal 
and vertical alignment. For this article, I have used the Basic 
Assembly, located in the Assemblies tab of the Tool Palette. Make 
sure to use the AIW_Existing_Ground as the target surface.

Now build a Corridor Surface using the Specify Code as Top. 

Figure 3

We are now finished with Civil 3D and can export it out to 3ds 
Max. To do this, click on the Output tab of the ribbon. In the 
Export panel, click Export to 3ds Max.

In the dialog box, uncheck your alignment, and make sure your 
corridor is checked. For surfaces, you only need to check the 
box for the corridor surface. Alternatively, you can also export 
the AIW_Existing_Ground, and in 3ds Max you can assign 
that existing ground an image. For this article, I’m opting out 
of that option.

Click Export.

This will create a .vsp3d file. We are finished with Civil 3D. Go 
ahead and close it.

Figure 2

http://www.augiworld.com
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3DS MAX AND CIVIL VIEW

Importing Your Road Design

Open 3ds Max. During installation of the software, there is 
a checkbox to install Civil View. You will need this installed 
before you can go any further. If you did not check the option 
to install it, you can do so by following the directions below:

1. Run the software installer and follow the on-screen in-
structions

2. On the screen where you check the box to include 3ds 
Max in the install, check 3ds Max for install

3. Click the drop-down triangle beneath the 3ds Max 
checkbox to open the options section

4. Scroll to locate and select the Civil View option

5. Close the Options section

6. Install

Once you’re ready, click Civil View in the menu. This will ini-
tiate the plug-in. Everything we will do from here on will be 
done inside of the Civil View pull-down menu. 

Click Civil View>Geometry Import>Civil 3D (VSP3D) file. 
Click the Open button, then browse to the file you exported 
out of Civil 3D (.vsp3d).

Once the dialog box appears, right-click on Corridors [1], and 
choose Select All.

Click OK.

3ds Max has a Global Import Shift because it doesn’t know 
coordinate zones. It cannot function too far away from the 0,0 
coordinate, so it shifts it. This is not important unless you 
wanted to import it back into InfraWorks.

Click Yes, then click Yes again.

You will now see your road with the daylighting features at-
tached to it.

Creating Your Scene: Adding Lamp Posts

Click on Civil View>Civil View>Object Placement Style 
Editor

This will bring up the Object Placement Style (OPS) Editor 
dialog box. From this dialog box, you will create your scene 
and animation. 

The first thing you need to do is select the Parent Shape 
button.

Figure 4

Figure 5
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When you move the cursor over the corridor, you will see the dif-
ferent lines that highlight. For this workflow, you are going to place 
everything off the centerline of road.

Click the centerline of the road.

Notice the Shape Name populates as a C3DfeatLine (a Civil 3D 
feature line). 

Now you can add the elements. Start with adding light poles. 

Click on the Add New Element button at the top of the dialog box.

There are six tabs at the bottom of the dialog box: Ve-
hicles, Furniture, Trees and Plants, Signs, Cameras, 
and Primitives. Click the Furniture tab, then highlight 
Lamp Columns. To the right, pick a style of lamp col-
umn (i.e., 45’ Single Column).

Under the Longitudinal Placement, toggle the radio 
button for Multiple (Regular Interval). The default in-
terval is 200’. Leave it at 200.0. 

Add a Horiz Offset. Start with 15.0. Click Apply and 
check to see if this is where you want the lamp posts. 
If not, change the Horiz Offset value, then click Apply 
to check it. Your dialog box should look something like 
Figure 7. 

At the top, under the Object Definition column, right-
click on the lamp post and choose Copy. Right-click 
again, and choose Paste.

Change the Horiz Offset to -15.0 and the Rotation to 
180.

Click Apply.

If you are satisfied with the way it looks, click Ok. You do not have 
to save the style, so select No.

Adding Street Signs

You are going to perform the same steps as before, but you will 
place signs instead of lamp posts.

Open the Object Placement Style (OPS) Editor by click Civil 
View>Civil View>Object Placement Style Editor.

Click the Parent Shape button, then select the center 
line of the road.

Click the Add New Element button at the top.  Click 
the Signs tab at the bottom. On the left, click Miscel-
laneous (15).

Under Longitudinal Placement, toggle the radio but-
ton for Multiple (Random Station). Change the Count 
to a lower number, something like 10.

To the right, under Other Options, check the box for 
Use Random Object(s) from the Selected Category.

Now set your Horiz Offset. Start with 30. Click Apply.

Your dialog box should look something like Figure 8. 

Figure 6

Figure 7

http://www.augiworld.com
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Figure 8

At the top, under the Object Definition column, right-click on the 
Random [Miscellaneous] and choose Copy. Right-click again, and 
choose Paste.

Change the Horiz Offset to -30.0 and the Rotation to 180.

Click Apply.

If you are satisfied with the way it looks, click Ok. You do not have 
to save the style, so select No.

The signs have sort of a transparency to them. They will not look 
like this with the final result.

Adding Vehicles

Once again, you are going to perform the same steps as before, but 
you will place vehicles instead of signs.

Open the Object Placement Style (OPS) Editor by click Civil 
View>Civil View>Object Placement Style Editor.

Click the Parent Shape button, then select the centerline of the road.

Click the Add New Element button at the top.  Click the Vehicles 
tab at the bottom. On the left, click Cars (16).

Under Longitudinal Placement, toggle the radio button for Mul-
tiple (Random Station). Change the Count to a lower number, 
something like 8.

To the right, under Other Options, check the box for Use Random 
Object(s) from the Selected Category.

Under Animation Options, set your miles/hr to 65.

Now set your Horiz Offset. Start with 5.5. Click Apply.

Move the “scrubber" bar at the bottom to make sure your vehicles 
are moving in the correct direction.

Figure 9

Your dialog box should look something like Figure 10. 

Figure 10
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Autodesk instructor with over 23 years 
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Texas area.  Todd is a valued member 
of the Infrastructure Support Division 
(ISD) for Graitec USA (formerly Total 
CAD Systems, Inc.), where he works 
as an Autodesk Instructor, Support 
Specialist, and Customer Success 
Manager. He also holds the “Autodesk 
Expert Elite” status—a program 
to recognize individual community 
members who have made extraordinary 
contributions with helping customers 
by sharing knowledge, providing 
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an engaging style of collaboration that 
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blogger, sharing tips and solutions 
through his personal blog website: 
civil3dj.wordpress.com. 

Note: If you want to use miles/hr instead of km/hr, then navigate 
to Civil View>Civil View>Preferences. Under the Localization 
tab, you can change the Distance Units to miles. Also, if you click 
the Resource Kit Paths tab, you can change the Active Country 
Resource Kit to US IMPERIAL.

At the top, under the Object Definition column, right-click on the 
Audi A3 and choose Copy. Right-click again, and choose Paste.

Change the miles/hr to a -65, the Horz Offset to -5.5 and the 
Rotation to 180.

Click Apply.

Move the scrubber bar to make sure your vehicles are moving cor-
rectly on both sides of the road.

If you are satisfied with the way it looks, click Ok. You do not have 
to save the style, so select No.

Adding a Camera Path

Click on Civil View>Civil View>Object Placement Style Editor.

Select the Parent Shape button, then pick the centerline of the road.

Click on the Add New Element button at the top of the dialog box.

At the bottom of the dialog box, click the Cameras tab. Select the Wide 
Angle Lenses (5) on the left. On the right side, choose the 035mm Lens.

Under the Animation Options, change the miles/hr to a value 
slower than the vehicles. For example, 40, since the cars are moving 
at 65 miles/hr. This will cause the cars to pass the camera and seem 
like a more realistic scene.

Add a Horiz Offset of 5.5, and a Vert Offset of 10.

Click OK and then No.

Animating Your Scene

For the final touch, you will animate your scene. Locate the in-
canvas visual style selector.

Click the word Perspective. Under Cameras, choose the Came-
035mm Lens-001. Once the scene jumps to the location, press the 
play button down toward the bottom right.

Figure 12

If you want to make a more realistic scene, you can add plants and 
trees. Also, you can look up how to create a sky with clouds to add 
to the scene to make it more realistic.

CONCLUSION

As you can see from this tutorial, there are many different ways to 
perform the same procedure in placing objects in your scene. There 
are also many other features in 3ds Max that will allow you to re-
ally bring your project to life.

I would love to hear your feedback on this article and see the proj-
ects for which you would like to use this workflow. Please feel free 
to call or email me anytime.

Figure 11

http://www.augiworld.com
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https://www.autodesk.com/products/revit-
live/viewer

AUTODESK LIVE VIEWER

Walk anywhere, experience everything—be-
fore breaking ground. Step inside your design with the Autodesk® 
Live Viewer.

Use the Autodesk Live Viewer to open and explore interactive vi-
sualizations created in Autodesk® Revit® Live, a subscription ser-
vice used by architects to make Revit files interactive.

Bring your interactive designs with you using the Autodesk Live 
Viewer. This powerful, portable communication tool also offers a 
highly engaging way to present or share your architectural vision 
with clients or project stakeholders.

Feature summary:

• Explore a space in virtual reality with just one click, using a 
HTC Vive or Oculus Rift headset.

• Navigate easily to different points in an architectural space.

• Toggle between the “Orbit” and “Tap&Go” perspectives to ex-
plore exterior and interior spaces.

• Stay in context with smart navigation that understands BIM 
object behaviors; you won’t veer off course or wander into walls.

• Adjust geography-specific lighting by date and time for a sense 
of where shadows will fall.

• Present compelling, interactive presentations on the go.

https://apps.autodesk.com/3DSMAX/en/
Detail/Index?id=7221085778557027350&
appLang=en&os=Win64

ADVARRAY

The AdvArray modifier is an advanced parametric array type mod-
ifier for 3ds Max®. Being that 3ds Max does not ship with any sort 
of parametric array modifier, AdvArray has been programmed to 
fill that void. In addition, it includes a number of advanced array 
features not found in 3ds Max by default, and even some that can-
not be found in other third-party modifiers.

https://apps.autodesk.com/RVT/en/De-
tail/Index?id=8420591257342001611&app
Lang=en&os=Win32_64

REVISION + CLOUD 
MANAGER

Smart manage revisions, clouds, and sheets.

 Revision Cloud Manager: 

• Automatically find corresponding sheet and detail number.

• Export to Excel schedule.

• Edit and update clouds in real time.

• Shows who is the last editor of a revision cloud (End User As-
sistant must be installed).

• Minimize hours and check for drafting mistakes.

• Only requires one person to install. Others use “Comments” 
property for information input.

Revision Manager:

• Manage sheets based on revisions.

• Batch assign revisions to sheets.

• Batch remove revisions from sheets.

• Save sheets as printset.

• Export sheet list with revision schedules to an Excel file.

If you have some news to share with us for future issues, please let 
us know. Likewise, if you are a user of a featured product or news 
item and would like to write a review, we want to know: brian.
andresen@augi.com

Welcome to AUGIWorld Inside Track! Check out the latest opportunities to 
advance your skills, processes, and workflows in your firm, with the most 
current AEC-related software and hardware updates available.

http://www.augiworld.com


Get the RiGht RAM
Even the highest speed Intel® processors can only do their job if they 
have the right memory (RAM) to support the computing tasks at 
hand.   Getting the right RAM is a function of three parameters:  
The total amount of RAM (in GB), the memory technology (DDR4 
being the latest) and the speed rating (expressed MHz).  By using 
an ample amount of the highest speed, highest technology memory 
the processor can support, you’ll achieve the greatest possible 
performance.

Select HP Z Workstations using the latest Intel® processors can 
support at least 32 GB of high speed DDR4-2400 RAM modules 
(with the HP Z440 and HP Z640 supporting far more).  By installing 
all available memory slots with the same size, same technology, same 
speed memory modules you’ll achieve the fastest possible memory 
performance.  And when in doubt, buy more RAM rather than less 
with 16 GB being the practical minimum for Autodesk applications.

hP tuRbo DRive G2
Since data files for Autodesk applications can be huge, workstation 
performance also depends highly on the speed of the disk storage 
utilized.  For the processor and RAM to do their job the data file must 
be loaded into the RAM and that means that the speed of the disk 
storage in the workstation is crucial.  In fact, spending good money 
on faster processors and RAM means little if the disk storage isn’t up 
to the task.

To achieve the highest disk throughput available, all HP Z 
Workstations support HP Z Turbo Drive G2 solid state drives 
(SSD’s).  Delivering 4x higher throughput than conventional SSD’s 
(and over 14x better than conventional SATA technology hard 
drives) HP Z Turbo Drive G2’s deliver from 250 GB to 1 TB of 
SSD storage to support everything from standard CAD to even the 
most aggressive rendering and analysis workflows.  For data intensive 
Autodesk applications an HP Z Turbo Drive G2 disk should be 
specified.

ConfiGuRe with hP PeRfoRMAnCe 
ADvisoR
When you acquire a new HP Z Workstation you’ll have a great tool 
at your disposal and you’ll likely install your Autodesk applications 
right away.  But how will you know that you have all the approved 
graphics drivers for those applications?  And over time how can you 
be sure that everything on the workstation stays up to date?  Add 
into the mix operating system updates, Microsoft .NET Framework 
updates for Autodesk tools and new versions of Autodesk software 
over the years and you can see that keeping a workstation up to date 
is not an easy task.

HP’s Performance Advisor is a software utility installed on every HP 
Workstation that deals with all the three vexing problems of keeping 
a workstation up to date – graphics driver maintenance, and system 
performance configuration.

how it woRks
In short, HP Performance Advisor keeps up with the components, 
drivers and software that are present on your HP Workstation and 
compares them to a database of known good drivers from HP to 
determine if everything is running optimally.  Far more than just 
telling you that something needs to be updated, Performance Advisor 
finds the correct graphics drivers for your system and software and 
installs them.  

In Performance Advisor each software program has individual 
parameter recommendations.  The workstation may be maintained 
simply by using the latest driver and and recommended BIOS settings 
to achieve the best performance.  So rather than having to check 
several software vendor’s web sites to figure out if your applications 
are up to date, Performance Advisor will do the work for you.

buy fAst now, stAy fAst LAteR
With HP Workstations you can leverage high performance Intel® 
technology, super fast memory and SSD architectures, and achieve 
optimal machine configurations with HP’s Performance Advisor.  
With HP and Intel® you don’t just buy a fast workstation, you buy a 
workstation and software system that maintains itself over time to give 
a low cost, high performance solution over the life of the workstation. 

About hP
HP helps you stay ahead of the curve with professional desktop 
and mobile workstations designed for large and complex datasets, 
dispersed teams, and tight deadlines. HP Z Workstations deliver the 
innovation, high performance, expandability, and extreme reliability 
you need to deliver your 3D CAD projects in less time. To learn how 
to configure a HP Z Workstation, visit the HP and Autodesk page at 
www.hp.com/go/autodesk. 

About RobeRt GReen
Robert Green provides CAD management consulting, programming, 
speaking, and training services for clients throughout the United 
States, Canada, and Europe. A mechanical engineer by training and 
alpha CAD user by choice, Robert is also well known for his insightful 
articles and book, Expert CAD Management: The Complete Guide. 
Reach Robert at rgreen@greenconsulting.com

Tech Insights

Get fast, stay fast 
with intel and hP

Achieve blistering speed with 
intel® processor technology, 
hP turbo Drives and hP 
Performance Advisor 

It’s no secret that Autodesk users want fast workstations. In fact, have 
you ever heard someone complain their workstation was too fast?  But 
have you ever experienced the problem of workstations becoming 
slower as time goes by due to system issues like obsolete drivers?  To 
obtain the best possible performance over the lifetime of a workstation 
you need not just the fastest processors, but also the fastest memory 
and disk systems with a continually optimized configuration that 
keeps up with technological change.  

Intel’s latest generation of Core™ and Xeon® processors give 
substantial core speed advantages over their predecessors and support 
super fast memory architectures available while HP’s Performance 
Advisor provides system optimization over the life of the workstation.  
In this edition of Tech Insights, we’ll examine some tips to get the 
best possible workstation for your needs and the best application 
performance over the life of your HP Workstation. 

 

HP Z240 SFF 
and Z240 Tower 
Workstations

stARt with the RiGht PRoCessoR
For CAD centric workflows like AutoCAD, Inventor and Revit a 
single processor architecture focusing on high clock rates can be 
found in HP’s Z2 Mini or Z240 Workstations.  Utilizing a range 
of available Intel® Core™ and Xeon® processors (including the 4.2 
GHz Intel® Core™ i7 7700K) CAD users can maximize the speed of 
their software via Intel® Turbo Boost Technology 2.0 to reach up to 
4.5 GHz core speeds in a cost efficient single processor architecture 
workstation.

For more aggressive workflows - like CAD combined with high 
performance rendering or analysis - high clock rates are still required 
yet more cores to handle the computational load will greatly benefit 
total workstation performance.  For these usage scenarios, the HP 
Z440 and Z640 Workstations configured with select Intel® Xeon® 
E5-1600v4 processors utilizing Turbo Boost Max Technology 
(TBMT) 3.0 provide multiple high-speed cores as seen in Figure 1.

Figure 1 – As cores go up base frequency drops but TBMT 3.0 technology 
always keeps two cores running at maximum boosted speeds.

➲

 

1. Multi-core is designed to improve performance of certain software products. Not all customers or 
software applications will necessarily benefit from use of this technology. Performance and clock frequency 
will vary depending on application workload and your hardware and software configurations. Intel’s 
numbering is not a measurement of higher performance. 
© Copyright 2017 HP Development Company, L. P. The information contained herein is subject to 
change without notice. The only warranties for HP products and services are set forth in the express 
warranty statements accompanying such products and services. Nothing herein should be construed as 
constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions 
contained herein. Intel, Core, Thunderbolt and Xeon are trademarks of Intel Corporation in the U.S. 
and/or other countries. 
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Get the RiGht RAM
Even the highest speed Intel® processors can only do their job if they 
have the right memory (RAM) to support the computing tasks at 
hand.   Getting the right RAM is a function of three parameters:  
The total amount of RAM (in GB), the memory technology (DDR4 
being the latest) and the speed rating (expressed MHz).  By using 
an ample amount of the highest speed, highest technology memory 
the processor can support, you’ll achieve the greatest possible 
performance.

Select HP Z Workstations using the latest Intel® processors can 
support at least 32 GB of high speed DDR4-2400 RAM modules 
(with the HP Z440 and HP Z640 supporting far more).  By installing 
all available memory slots with the same size, same technology, same 
speed memory modules you’ll achieve the fastest possible memory 
performance.  And when in doubt, buy more RAM rather than less 
with 16 GB being the practical minimum for Autodesk applications.

hP tuRbo DRive G2
Since data files for Autodesk applications can be huge, workstation 
performance also depends highly on the speed of the disk storage 
utilized.  For the processor and RAM to do their job the data file must 
be loaded into the RAM and that means that the speed of the disk 
storage in the workstation is crucial.  In fact, spending good money 
on faster processors and RAM means little if the disk storage isn’t up 
to the task.

To achieve the highest disk throughput available, all HP Z 
Workstations support HP Z Turbo Drive G2 solid state drives 
(SSD’s).  Delivering 4x higher throughput than conventional SSD’s 
(and over 14x better than conventional SATA technology hard 
drives) HP Z Turbo Drive G2’s deliver from 250 GB to 1 TB of 
SSD storage to support everything from standard CAD to even the 
most aggressive rendering and analysis workflows.  For data intensive 
Autodesk applications an HP Z Turbo Drive G2 disk should be 
specified.

ConfiGuRe with hP PeRfoRMAnCe 
ADvisoR
When you acquire a new HP Z Workstation you’ll have a great tool 
at your disposal and you’ll likely install your Autodesk applications 
right away.  But how will you know that you have all the approved 
graphics drivers for those applications?  And over time how can you 
be sure that everything on the workstation stays up to date?  Add 
into the mix operating system updates, Microsoft .NET Framework 
updates for Autodesk tools and new versions of Autodesk software 
over the years and you can see that keeping a workstation up to date 
is not an easy task.

HP’s Performance Advisor is a software utility installed on every HP 
Workstation that deals with all the three vexing problems of keeping 
a workstation up to date – graphics driver maintenance, and system 
performance configuration.

how it woRks
In short, HP Performance Advisor keeps up with the components, 
drivers and software that are present on your HP Workstation and 
compares them to a database of known good drivers from HP to 
determine if everything is running optimally.  Far more than just 
telling you that something needs to be updated, Performance Advisor 
finds the correct graphics drivers for your system and software and 
installs them.  

In Performance Advisor each software program has individual 
parameter recommendations.  The workstation may be maintained 
simply by using the latest driver and and recommended BIOS settings 
to achieve the best performance.  So rather than having to check 
several software vendor’s web sites to figure out if your applications 
are up to date, Performance Advisor will do the work for you.

buy fAst now, stAy fAst LAteR
With HP Workstations you can leverage high performance Intel® 
technology, super fast memory and SSD architectures, and achieve 
optimal machine configurations with HP’s Performance Advisor.  
With HP and Intel® you don’t just buy a fast workstation, you buy a 
workstation and software system that maintains itself over time to give 
a low cost, high performance solution over the life of the workstation. 

About hP
HP helps you stay ahead of the curve with professional desktop 
and mobile workstations designed for large and complex datasets, 
dispersed teams, and tight deadlines. HP Z Workstations deliver the 
innovation, high performance, expandability, and extreme reliability 
you need to deliver your 3D CAD projects in less time. To learn how 
to configure a HP Z Workstation, visit the HP and Autodesk page at 
www.hp.com/go/autodesk. 

About RobeRt GReen
Robert Green provides CAD management consulting, programming, 
speaking, and training services for clients throughout the United 
States, Canada, and Europe. A mechanical engineer by training and 
alpha CAD user by choice, Robert is also well known for his insightful 
articles and book, Expert CAD Management: The Complete Guide. 
Reach Robert at rgreen@greenconsulting.com

Tech Insights

Get fast, stay fast 
with intel and hP

Achieve blistering speed with 
intel® processor technology, 
hP turbo Drives and hP 
Performance Advisor 

It’s no secret that Autodesk users want fast workstations. In fact, have 
you ever heard someone complain their workstation was too fast?  But 
have you ever experienced the problem of workstations becoming 
slower as time goes by due to system issues like obsolete drivers?  To 
obtain the best possible performance over the lifetime of a workstation 
you need not just the fastest processors, but also the fastest memory 
and disk systems with a continually optimized configuration that 
keeps up with technological change.  

Intel’s latest generation of Core™ and Xeon® processors give 
substantial core speed advantages over their predecessors and support 
super fast memory architectures available while HP’s Performance 
Advisor provides system optimization over the life of the workstation.  
In this edition of Tech Insights, we’ll examine some tips to get the 
best possible workstation for your needs and the best application 
performance over the life of your HP Workstation. 

 

HP Z240 SFF 
and Z240 Tower 
Workstations

stARt with the RiGht PRoCessoR
For CAD centric workflows like AutoCAD, Inventor and Revit a 
single processor architecture focusing on high clock rates can be 
found in HP’s Z2 Mini or Z240 Workstations.  Utilizing a range 
of available Intel® Core™ and Xeon® processors (including the 4.2 
GHz Intel® Core™ i7 7700K) CAD users can maximize the speed of 
their software via Intel® Turbo Boost Technology 2.0 to reach up to 
4.5 GHz core speeds in a cost efficient single processor architecture 
workstation.

For more aggressive workflows - like CAD combined with high 
performance rendering or analysis - high clock rates are still required 
yet more cores to handle the computational load will greatly benefit 
total workstation performance.  For these usage scenarios, the HP 
Z440 and Z640 Workstations configured with select Intel® Xeon® 
E5-1600v4 processors utilizing Turbo Boost Max Technology 
(TBMT) 3.0 provide multiple high-speed cores as seen in Figure 1.

Figure 1 – As cores go up base frequency drops but TBMT 3.0 technology 
always keeps two cores running at maximum boosted speeds.

➲

 

1. Multi-core is designed to improve performance of certain software products. Not all customers or 
software applications will necessarily benefit from use of this technology. Performance and clock frequency 
will vary depending on application workload and your hardware and software configurations. Intel’s 
numbering is not a measurement of higher performance. 
© Copyright 2017 HP Development Company, L. P. The information contained herein is subject to 
change without notice. The only warranties for HP products and services are set forth in the express 
warranty statements accompanying such products and services. Nothing herein should be construed as 
constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions 
contained herein. Intel, Core, Thunderbolt and Xeon are trademarks of Intel Corporation in the U.S. 
and/or other countries. 
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I
n previous articles, I’ve mentioned how details 
affect our work. I’d like to expand on that by pre-
senting two methods you can use to add complex 
details to your scenes quickly. 

IMPORTING AND WORKING WITH 
PATHS FROM PHOTOSHOP

I’ll start with the metallic lion mounted on the pillar shown in Fig-
ure 1.  Using Adobe Photoshop with 3ds Max®, we can add objects 
like this lion to our scene in just a few minutes.

Expanding 
on Details

Figure 1

http://www.augi.com
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First, locate (or create) an image similar to the one in Figure 2.  
Open the file with Adobe Photoshop. Refer to Figure 2 where 
I marked the following steps in numerical order. Using the 
magic wand tool (1) with the contiguous option unchecked 
(2), click a point on the image that makes up the shape you 
want to import into 3ds Max.  Once the shape is selected, 
navigate to the Paths tab (3) and select the Make Work Path 
from Selection option (4).  Next, export the path to an Adobe 
Illustrator format using the File Menu -> Export -> Paths to 
Illustrator option.

Figure 2

In 3ds Max, select the File menu and choose Import to im-
port the file. 3ds Max will ask if you want to merge the file 
into the current scene, completely replace the scene, and if you 
want the path to be a single object or multiple objects. Once 
your selections are complete, 3ds Max will insert the path as 
an editable spline. Apply the Edit Poly modifier to the spline 
object(s). You can now extrude the faces or work with the ob-
ject however you’d like. 

WORKING WITH THE 
DISPLACE MODIFIER

With the Displace modifier we can en-
grave or emboss images in our objects 
to add detail or use as guides for recon-
struction.  See the tiger engraved into 
the wall of the child’s room in Figure 3. 
Like the lion, this took just a few min-
utes to create.

First, select an image similar to the one 
displayed in Figure 2.  I chose an im-
age of a tiger for this exercise.  Insert a 
plane with length and width segments 
set to one.  Next, apply the Subdivide 
modifier and navigate to its parameters. 
Since we are trying to engrave a fairly 
detailed image into our object we need 
to adjust the size of the subdivision un-
til we have plenty of triangles to form 
our shape.

Next, apply the Displace modifier. The 
Displace modifier has several proper-
ties. Start by selecting your image using 
the button in the bitmap category iden-
tified as step 1 in Figure 4.  Be sure to 
adjust the image to fit your particular 
plane by using the Bitmap Fit option 
under the Alignment category marked 
by number 2 in Figure 4. 

Finally, adjust the strength, decay, and 
blur values until you achieve the level 
of detail you want. If you have trouble 
achieving the desired detail, you may 
have to readjust the Subdivide modifier 
parameters to have a higher number of 
triangles to work with.

Please note there are usually alternate 
methods to achieving desired results. For example, normal bump 
maps could be used with materials or the displace feature could 
be applied through a material to achieve similar results that I pre-
sented in this article.  It’s just a matter of exploring the options and 
applying them as they are appropriate for your needs.

Brian Chapman is an Autodesk 
Authorized Developer, creator of 
Pro-Cad.Net and Senior Designer 
for Slater Hanifan Group, a civil 
engineering and planning firm 
dedicated to superior client service. 
Brian can be reached at procadman@
pro-cad.net.

Figure 4

Figure 3
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 by: Melinda Heavrin

AEC  
Wall  
Objects

I
n AutoCAD® Architecture, a wall is an AEC 
object that represents the real-world features 
of an interior or exterior wall.  The wall object 
contains all the geometry needed to represent a 

wall in 2-dimensional (2D) and 3-dimensional (3D) 
views.  Walls are the basic components of any building plan.  You 
can create very simple wall types that rely on standard settings and 
add them on the fly.  A wall has one or more components, which 
are the materials used to construct the wall.  Some components 
include brick, CMU, concrete, studs, air gaps, and insulation.  The 
components of walls can also have modifiers, which change the 
shape of the component or its surface.

Wall styles control the appearance of wall objects.  With wall 
styles, you can specify components, endcaps, materials, and other 
characteristics to create new types of walls, such as concrete walls, 
masonry walls, and brick cavity walls (see Figure 1).  Catalogs 
provided with AutoCAD Architecture include sample wall styles 
for common wall types, such as concrete walls with footings or 
furring, CMU and brick cavity walls, and various stud partition 

walls.  You can also work with casework wall styles that include 
counters, base units, and upper units.

When you add a wall to a drawing, you select a wall tool and then 
specify the points that define each wall segment.  A wall can have 
both straight and curved segments.  Wall direction is significant 
for some modifications to walls.  Sample wall styles provided with 
AutoCAD Architecture were created with the intent that you 
place perimeter walls in clockwise fashion.  After placing a wall, 
you can determine the wall direction by selecting the wall.  The 
wall direction grip indicates the wall direction.  

You can also reverse the direction of a wall.  When you add doors, 
windows, door/window assemblies, and openings to a wall, the 
wall automatically adjusts to accommodate the object and adds 
endcaps where needed.  By default, these objects are anchored to 
the wall and remain with the wall if you move it.  If you remove 
an object from a wall, the wall repairs itself in the space where the 
object was located.
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Figure 1: Style Manager

WALL STYLES

Many characteristics of a wall are determined by the wall style. You 
can create simple wall styles that have a more symbolic display, or 
you can create detailed walls styles with a representational display, 
containing many elements the real wall will have.  These settings 
are defined in the wall style:

• Property Set data – if you want to tag a wall in a drawing or 
include it in a schedule table, you need to attach property set 
data to the wall or the wall style.  Property data attached to a 
wall style typically contains automatic properties, like the wall 
height or the wall width, or manual properties that are identical 
for all walls of that style, such as the fire rating, for example.

• Wall Components – in a wall style, you can define wall 
components.

• Materials – in a wall style, you can define materials for the 
2D and 3D display of walls, as well as for the rendering dis-
play of the wall.   You assign materials to the wall compo-
nents in the style.  The components are then displayed using 
the display properties of the assigned materials.  AutoCAD 
Architecture provides a large number of predefined materials 
for common design purposes.  You can use these materials, 
modify them for your project requirements, and define new 
materials.  To use a material in a wall style, it needs to be 
defined first in Style Manager.

• Specifying Wall Display – the visual appearance of a wall is de-
fined in the wall style.  Define the layer, color, linetype settings 
of the individual wall components, hatching, and the cut plane 
display of the wall in plan views.  The display settings defined in 
the wall style can be overridden for an individual wall. 

• Specifying Default Wall Settings – access the Options dialog 
box and specify the defaults for dimensioning walls and for wall 
cleanup.  The cleanup settings apply only to new walls.

• Using Wall Tools – tools provided with AutoCAD Architecture 
let you quickly place walls by selecting a wall tool with a specific 

wall style and other predefined properties (see Figure 2).  You 
can also use wall tools to convert linework to walls and to apply 
the settings of a wall tool to existing walls.  You can also access 
Stock Tool, Sample palette, and Design Tool catalogs.  When 
you place walls using wall tools, you can use the default settings 
of the tool or you can change settings for any wall properties 
that are not controlled by the style.

You can work with wall and opening endcaps to create endcap 
conditions:

• Modifying Wall Endcaps with Edit in Place Grips – you can 
use Edit in Place grips to modify wall endcaps and create the 
wall endcap conditions that you want.  Vertex and Edge grips 
are displayed for all wall components at the wall endcap that 
you specify.

• Creating Wall Endcaps with Calculate Automatically – 
you can use the Calculate Automatically feature with appropri-
ate polyline linework to create wall endcaps.  Calculate Auto-
matically will add boundary segments to complete an endcap 
configuration if the initial polyline is drawn with regard to loca-
tion and orientation of the particular wall component.

• Creating Wall Endcaps with AEC Modify Tools – you can use 
AEC Modify Tools to manipulate wall components to create ap-
propriate wall endcap configurations.  Use Trim, Extend, Sub-
tract, and Merge tools as necessary to do this.  You can modify 
single wall components or you can modify all components at 
your wall endcap or opening at once. 

• Specifying Wall Endcaps by Style – in the wall style, you can 
define endcaps for the wall start and end.  The standard endcap 
style is a straight line.  If you need different endcaps, you need 
to create a wall endcap style and then assign it to the wall style.

• Specifying Opening Endcaps by Style – in the wall style, you 
define the endcaps for any doors, windows, and openings 
inserted in the wall.  By default, the opening endcaps are four 
straight lines for the jamb start and end and the sill and head of 
the opening.

Figure 2: Wall Styles

http://www.augiworld.com
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EDITING WALLS

After placing a wall, you can change its style, location, size, shape, 
basic geometry, and override the component priorities and the 
endcap styles of the wall.  You can also move a wall, merge or 
join walls, reverse the direction of a wall, and change the shape 
of the roof line and the floor line of a wall.  In addition, you can 
modify walls using other objects as interference conditions or 
body modifiers.

Depending on the type of editing you want to perform, various 
methods may be available:

• After selecting a wall, you can click any non-grip point along the 
perimeter and drag the entire object to a new location. 

• You can drag the grips that are displayed on a selected wall to 
reorient it, resize it, or change other physical characteristics.

• For grip edits where you are changing a dimension or an angle, 
the Dynamic Input feature lets you enter a precise value instead 
of moving a grip. 

• You can apply the properties of a wall tool to an existing wall or 
the properties of a curtain wall tool, slab tool, or roof slab tool 
to an existing wall.

• You can change settings on the Properties palette (see Figure 3).

• You can use editing commands from the object’s context menu.

CUSTOMIZED WALL SURFACES

Wall sweeps, wall (plan) modifiers, body modifiers, and interference 
conditions are features that you can use to create special conditions, 
such as chases, and to customize wall surfaces.  These menus can 
be found when you right click on a wall (see Figure 4).

A wall sweep is a wall or a wall component whose shape is 
extruded horizontally from a profile that was created from a 
closed polyline.  The profile “sweeps” along the length of the 
wall to define the shape of the wall or the wall component.  
The height and the width of the polyline you use to create the 
profile define the height and the width of the wall component.  
The profile is not scaled when swept on the wall.  The inser-
tion point of the profile becomes the lower-left corner of the 
wall component.  After you create wall sweeps, you can miter 
wall sweeps that meet at a corner.  You can also change how the 
sweep is applied to the wall:

• You can edit the geometry that defines a sweep.

• You can assign a sweep profile to a different wall component.

• You can adjust the miter angles at each end of a wall that has a 
sweep profile.

• You can remove a sweep profile from a wall or a wall component.

Wall modifiers use the 2-dimensional (2D) geometry of an 
open polyline to customize the shape of a wall or a wall com-
ponent. To use wall modifiers, you draw a polyline in the shape 
you need and create a wall modifier style from the polyline. You 
can then add wall modifiers of that style to any wall.  A wall can 
have more than one wall modifier attached to it.  You specify 
the placement of a wall modifier, including its vertical and hori-
zontal position and its depth.  The wall modifier can be added 
at the drawn size of the polyline or scaled to a specific size.  The 
wall modifier is then extruded vertically along the wall surface.  
You can add the wall modifier to one or both sides of the wall.  
When you select the face, you can also offset the wall modifier 
from the opposite face to create a bump-out, such as for pipe 
chases or interior columns.  

After placing a wall modifier, you can adjust its placement, or 
assign the modifier to a different wall component.  You can also 
edit the geometry of the wall modifier and save the changes to 
the current wall modifier style or to a new style.  Wall modifiers 
take on the material assignment and the display properties of 
the wall component to which they are assigned.  This allows 
you to use the same wall modifier on different types of walls.  
You save the geometry of a wall modifier as a wall modifier 
style.  You can create the style when you add the wall modifier 
to a wall.  You can also create a wall modifier first and then ap-
ply it to walls as needed.

Body modifiers use the 3-dimensional (3D) geometry of an ob-
ject, such as a mass element or a mass group, to add to, subtract 
from, or completely replace one component in a wall.  If the wall 
has only one component, the body modifier applies to the entire 

Figure 3: Properties palette
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wall.  If the wall has multiple components, the modifier applies 
only to the component that you specify.    If you add the body 
modifier to a wall component, or use a body modifier to replace 
the component, the body modifier uses the material assignment 
and display properties of the wall component.  After you create a 
body modifier from an object, you can delete the original object.  
However, if you have created a complex object, such as a mass 
group comprising many mass elements, you may want to retain 
the object in the drawing until you are sure you have the results 
you want for the wall.

Interference conditions use the geometry of 3D objects to cre-
ate custom openings or cutouts in walls.  You can specify how 
the interference condition is applied to the wall: added to the 
wall, subtracted to the wall, or ignored.  Interference conditions 
apply to all wall components that the interfering object touches.  
The wall stops at the interference condition.  The way in which 
you apply the interference condition to the wall determines 
how the shrink-wrapping of the wall is affected by the condi-
tion in plan view. 

In model views, the interference condition is always subtractive, 
regardless of the shrink-wrapping option you selected.  When 
you edit the object that acts as the interference condition, the 
wall changes to accommodate the changes to the geometry of 
the object.  For example, you can move the interfering object to 
change its location on the wall.   When you edit the object that 
acts as the interference condition, the wall changes to accom-
modate the changes to the geometry of the object.  For example, 
you can move the interfering object to change its location on 
the wall.  Moving the object off the wall does not remove the 
interference condition for the object.  You can also change how 
interference conditions are applied to a wall, and you can delete 
interference conditions.

Figure 4: Wall menu

WALL AND OPENING ENDCAPS

You can define different kinds of wall endcaps and wall opening 
endcaps conditions.  When you encounter an unsuitable wall end-

cap configuration, you can modify the shape, width, and depth of 
individual wall components to achieve the desired result.  

Generally, you create a specific wall or opening endcap condition 
to use with a specific wall style.  To modify endcaps, you can use 
the Edit in Place mode and manipulate wall components with Ver-
tex and Edge grips.  You can hide or show component edges.  You 
can also use Fillet, Chamfer, Trim, Extend, Subtract, and Merge 
tools to modify wall components to create the configuration that 
you want.  The Calculate Automatically feature can also assist you 
in adding boundary segments to complete your partial endcap 
designs.  When necessary, you can override the wall endcap style 
assigned in a wall style.  When you override the assigned endcap 
style, you can select a different endcap style for one or both ends 
of a wall segment.

Wall endcap styles are also used as a basis to define endcap 
styles for wall openings (see Figure 5).  When a wall has an 
opening, such as a window or a door, the shape of the wall end-
cap at each edge of the opening can be defined.  You use open-
ing endcap styles to specify the wall endcap style applied to 
each edge of the wall adjacent to an opening.  When you change 
a wall endcap style, all opening endcap styles based on that style 
are also modified.

Figure 5: Wall endcap styles

Melinda Heavrin is a CAD 
Coordinator & Facility Planner for 
Norton Healthcare in Louisville, 
Kentucky.  She has been using 
AutoCAD Architecture since release 
2000.  Melinda can be reached for 
comments and questions at melinda.
heavrin@nortonhealthcare.org.
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by: Melanie Perry

16th Annual AUGI 
Salary Survey

Please keep an eye out for email blasts, social media channel updates and the 
surveys column in HotNews next summer so you can participate, too!

I 
have to start out by thanking so many of our 
members for taking time out of their days to 
volunteer the information that makes this 
report possible. You can be assured that the 

higher the number of responses received, the more 
accurate the reported numbers are.  Just as with all of the AUGI 
programs, volunteers like me and these survey participants are 
what make the magic happen in our community.

In 15 years overseeing this report, I constantly receive and con-
sider feedback from the membership, so as always (once you’ve 
read the FAQ) feel free to send me any suggestions for Hot 
Topic issues you’d like to see gauged, or other important statis-
tics which may have been neglected.

The first question is always the differences in Cost of Living 
in various areas. Thirty percent of survey participants are from 
outside of the US, and the metro areas and rural areas can be 
costly or affordable no matter the country, so be sure to check lo-
cal resources for those variances. I am a big fan of www.Indeed.
com/Salary and the ETC Salary Calculator, as well as industry- 
or role-specific surveys from other professional organizations. 
The salaries reported here (in US dollars , as participants were 
given a link to a currency convertor) reflect salary and bonuses 
for those who work 40 hours a week; they are calculated to ex-
clude overtime pay.

Negative factors ( job insecurity, layoffs, reduced pay) continue 
to decline slowly, while those starting new jobs are on a slight 
increase.  Market share for industry specialties hasn’t changed 
much since last year. Keep reading to see which market seg-
ments are doing the most hiring. 

Wages in larger companies average 14 percent higher than 
those in the smallest firms. Regular use of cloud services has 
increased from 3 percent of respondents to 5 percent since last 
year, though most are still resisting due to company policy and 
other concerns. However, use of cloud services on a limited 
number of a company’s projects has jumped from  12 percent 
to 15 percent (when we first asked this question, only 5 percent 
were using cloud services in this manner). 

Although 74 percent of our respondents are still in the same job 
they were last year, only a record low 44 percent  intend to stay 
that way. We see in the March job search poll that 22 percent of 
users are currently searching for a new job due to dissatisfaction 
with their current role, and a further 10 percent plan to start 
looking soon.

Without a doubt, most folks get their jobs through personal 
connections (45 percent), so be sure to reach out to your pro-
fessional connections and start networking. And, when you get 
that new job offer, don’t forget to negotiate your salary. 

Thank you to the over 4,100 members 
who took the time to contribute to this 

resource for users, by users!

Lets dig in and see what has been 
happening in our industry since last 

year’s survey. 
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DEMOGRAPHICS
Employee Gender

 

Male 81%

Female 19%

47% of respondents have a Bachelor’s 
degree or higher, compared to 27% 
when this annual survey began in 2002.

Average Pay by Years of Experience
0-2 years $51,817

3-4 years $55,708

5-6 years $59,132

7-8 years $53,247

9-10 years $62,292

11-12 years $62,963

13-14 years $64,362

15-20 years $67,317

21-30 years $72,367

31-50 years $84,173
0 20 40 60 80 100

Respondents’ Years of Experience
0-2 years 5%

3-4 years 6%

5-6 years 7%

7-8 years 5%

9-10 years 8%

11-12 years 7%

13-14 years 5%

15-20 years 23%

21-30 years 21%

31-50 years 12%
0 5 10 15 20 25

Overall $66,797

Male $67,688

Female $62,938

Pay by Gender

0 10 20 30 40 50 60 70 80

Check out these resources for additional 
information on pay:
• Indeed.com/salary
• Salary.com    
• Payscale.com    
• ETC Salary Calculator  
• Glassdoor    
Search for other professional organizations 
related to your market to get more niche data.

Average Pay By Education Level
(for those with 5 or fewer years of experience)

High School/ 
GED $48,181

Technical/ 
Vocational $56,356

Associates Degree 
(2 years) $55,249

Bachelors Degree 
(4-5 years) $56,558

Masters 
Degree $54,768

0 10 20 30 40 50 60

Education Level/Degree Attained
High School/ 
GED 6%
Technical/ 
Vocational 18%

Associates  
Degree (2 years) 29%

Bachelors Degree  
(4-5 years) 34%

Masters 13%

Doctorate <1%
0 5 10 15 20 25 30 35

Urban $67,840

Suburban $64,505

Rural $64,290

Pay By Work Location

0 10 20 30 40 50 60 70 80

http://www.augiworld.com
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Does Your Company Have a Human 
Resources Department?

Yes 70% 

N/A 2%

No 28%

Change in Employment?
No, still the same job 74%

Yes, left for a new 
company 10%
No, but, my workload 
has increased 9%
Yes, same company, 
different job 4%
Yes, I was laid off 2%

No, but my hours 
were reduced 1%

How Many Years Have You Worked for Your 
Current Employer?

Less than 5 51%

5-10 18%

11 or more 31%
0 10 20 30 40 50 60

Number of Employees in Company
10 or fewer 12%

11 - 25 12%

26 - 50 12%

51 - 100 12%

101 - 200 12%

201 - 500 13%

Greater than 500 28%
0 5 10 15 20 25 30

Age of Respondents

Under 30 11%

30-39 32%

40-49 27%

50-59 23%

60 and Over 8%

Lack of benefits reduces average job 
satisfaction scores by more than 16%.
The ability to telecommute trans-
lates to  job satisfaction 8% higher 
than the average worker.

Average Pay by Company Size 
(Number of Employees)

10 or fewer $60,856

11 - 25 $63,150

26 - 50 $64,290

51 - 100 $64,950

101 - 200 $66,173

201 - 500 $68,745

Greater than 500 $72,657
0 10 20 30 40 50 60 70 80

COMPANY DATA

What Benefits Are Available To You? 

0 20 40 60 80 100

Paid Time Off 96%

Medical Insurance 88%

Retirement 81%

Dental Insurance 74%

Flexible Hours 61%

Continuing Education 49%

Telecommuting 24%

Childcare Assistance 9%

None of the Above 4%
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Reminder: All reported average pay 
is based upon a 40 hour work week. 
It would include potential bonuses, 
but workers who are paid hourly 
and earn overtime should expect 
their pay to be higher than the ave-
rage shown here.

JOB TITLES

Survey Participants

0 5 10 15 20 25

Designer 23%
Drafter 11%
Manager - BIM 10%
Architect 9%
Manager - CAD 9%
Engineer 8%
Technician 7%
Manager - Project 5%
Coordinator - BIM 5%
Specialist 3%
Manager - Other 3%
Coordinator - CAD 2%
Instructor / Trainer 1%
Coordinator - Other <1%
Land Surveyor <1%
Application Engineer <1%
Intern <1%
Programmer <1%
Account Executive <1%

Current Workload 

Extremely Busy 47%

Same as Always 37%

A Bit Slow 15%

Pretty Bad 2%
0 10 20 30 40 50

Yes, I do not deal with any work until I return 30%

Yes, but exceptions for urgent issues 46%

No, I remain available to those in my company 14%

No, I am constantly connected for anyone to reach me 11%

When You Leave for the Day, Are You 
Really Leaving Work?

0 10 20 30 40 50

Land Surveyor  $79,029 

Programmer  $78,438 

Account Executive $77,722 

Manager - Other  $77,644 

Manager - CAD  $75,956 

Manager - BIM  $75,153 

Manager - Project  $70,707 

Architect  $69,295 

Coordinator - CAD $68,599 

Application Engineer $68,105 

Engineer  $67,781 

Instructor/Trainer $67,603 

Specialist  $64,967 

Designer  $64,687 

Coordinator - BIM $62,622 

Coordinator - Other $58,868 

Technician  $55,921 

Drafter  $55,400 

Intern  $54,825 

Average Pay by Job Title

0 10 20 30 40 50 60 70 80

Jobs with the Highest Mobility  
(Percentage of Each Who Reported Leaving for a New Role)

Specialist 22%

Coordinator - BIM 19%

Architect 15%

Manager - BIM 13%

Coordinator - Other 11%

Manager - Project 11%

Drafter 10%

Engineer 10%

Designer 9%

Land Surveyor 9%

Technician 8%

Intern 7%

Manager - Other 7%

Coordinator - CAD 6%

Programmer 5%

Manager - CAD 5%
0 5 10 15 20 25

http://www.augiworld.com
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The average age of an AUGI member 
is 43. 
Fields with higher than average em-
ployee age are education, electronics, 
facilities, and manufacturing
19% of the industry is female. 
Fields with lower than average female 
representation are sales, fuels, manu-
facturing, MEP/FP, and construction.

INDUSTRY/DISCIPLINE

0 5 10 15 20 25 30

Survey Participants
Architecture 27%
Civil/Survey/GIS 20%
Construction 13%
MEP/FP 12%
Manufacturing 8%
Structural 8%
Petroleum/Gas/Biofuels 3%
Facility Management 2%
Education/Training 2%
Interior Design 1%
Electronics <1%
Landscape Design/Architecture <1%
Sales/Marketing <1%

Average Pay by Field/Industry

0 20 40 60 80 100

Petroleum/Gas/Biofuels $82,263
Civil/Survey/GIS $68,158
Construction $66,759
MEP/FP $66,509
Facility Management $66,471
Structural $66,129
Education/Training $64,859
Architecture $64,613
Manufacturing $63,905
Electronics $63,269
Landscape Design/Architecture $60,375
Interior Design $59,007
Sales/Marketing $54,975

Percentage Extremely Busy Workload

0 10 20 30 40 50

Construction 49%
Architecture 49%
MEP/FP 49%
Electronics 48%
Civil/Survey/GIS 46%
Structural 46%
Manufacturing 45%
Interior Design 45%
Facility Management 43%
Landscape Design/Architecture 40%
Education/Training 38%
Petroleum/Gas/Biofuels 27%
Sales/Marketing 13%

0.0 0.5 1.0 1.5 2.0 2.5 3.0 3.5 4.0

Petroleum/Gas/Biofuels 4%
Facility Management 4%
Interior Design 3%
Manufacturing 2%
Architecture 2%
Construction 2%
MEP/FP 2%
Civil/Survey/GIS 1%
Structural 1%

Percentage Reporting Being Laid Off 

Industries with Highest Percentage of Job 
Secure Rankings
Education/Training 84%
MEP/FP 84%
Civil/Survey/GIS 82%
Manufacturing 81%
Structural 80%
Construction 78%
Architecture 78%
Facility Management 77%
Interior Design 75%
Landscape Design/Architecture 72%
Electronics 70%
Petroleum/Gas/Biofuels 62%
Sales/Marketing 60%

0 20 40 60 80 100



AUGI 2017 Salary Survey IN
D

U
ST

R
Y

 F
O

C
U

S

September 2017 www.augiworld.com  39

MARKETS SERVED - INDUSTRY SPECIALTIES

0 20 40 60 80 100

AEC - Commercial 92%
AEC - High-End Residential 83%
AEC - Government 70%
AEC - Healthcare 62%
AEC - Residential 58%
AEC - Facility Management 57%
AEC - Educational 54%
ENG - Utilities 39%
AEC - Retail 35%
ENG - Structure 33%
ENG - Sustainability 33%
ENG - Software Development 27%
ENG - Mining 26%
ENG - MEP 23%
ENG - Process Plant 19%
ENG - Bridges 17%
EDU - Independent Trainer/Consultant 12%
EDU - Vocational/Technical 11%
EL - Building Automation Systems 11%
Mfg - Consumer Goods 10%
Mfg - Automotive 10%
EL - Audio/Visual 8%
EDU - University 8%
EDU - Primary/Secondary 8%
Mfg - Aerospace 8%
ME - Design Visualization 8%
EL - Telecommunications 7%
Mfg - Medical 6%
Mfg - Tool/Die/Molding 6%
ME - Games 4%
Mfg - Shipbuilding 4%
Mfg - Semiconductor 3%
EDU - VAR (Reseller) 2%
ME - Film 1%
ME - TV <1%

Size of Market Segments

Highest Average Paid Specialty by Industry
ME - TV $76,397
ENG - Process Plant $73,484
MFG - Shipbuilding $69,129
EL - Building 
Automation Systems $68,466
EDU - Independent 
Trainer/Consultant $68,069
AEC - Facility 
Management $68,205

0 10 20 30 40 50 60 70 80

Average Pay of Market Segments
AEC - Commercial $66,347
AEC - High-End Residential $66,473
AEC - Government $67,603
AEC - Healthcare $67,073
AEC - Residential $64,897
AEC - Facility Management $68,205
AEC - Educational $67,053
ENG - Utilities $71,671
AEC - Retail $67,197
ENG - Structure $67,913
ENG - Sustainability $70,380
ENG - Software Development $67,541
ENG - Mining $68,600
ENG - MEP $68,476
ENG - Process Plant $73,484
ENG - Bridges $68,972
EDU - Independent Trainer/Consultant $60,069
EDU - Vocational / Technical $64,007
EL - Building Automation Systems $68,466
Mfg - Consumer Goods $64,221

0 10 20 30 40 50 60 70 80

Percentage of Each Market Reporting 
Extreme Busyness
EL - Telecommunications 49%
AEC - Retail 47%
EDU - University 44%
ENG - MEP 39%
Mfg - Medical 37%
ME - TV 36%
AEC - Educational 34%
ENG - Process Plant 33%
ME - Film 32%
ENG - Structure 31%
AEC - Commercial 31%
ENG - Bridges 30%
ENG - Utilities 27%
AEC - Residential 27%

0 10 20 30 40 50

Markets Reporting Poor Workload
Mfg - Tool/Die/Molding 28%
ENG - Process Plant 3%
EDU - VAR (Reseller) 3%
Mfg - Shipbuilding 2%
Mfg - Semiconductor 2%
ENG - Structure 2%

0 5 10 15 20 25 30

http://www.augiworld.com
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HOT TOPICS

0 10 20 30 40 50 60

Reduced wages or changed benefits 9%
Increased wages or improved benefits 44%
Reduced Staff 
(layoffs or not replacing those who leave) 22%
Increased Staff 55%
Closed locations/offices/sites 7%
Opened locations/offices/sites 18%
Allowed subscriptions to lapse 5%
Purchased new software and/or hardware 59%
Increased outsourced/contracted work 20%
Decreased outsourced/contracted work 4%
No such changes 10%

Has Your Company Done Any of the 
Following in the Past Year?

Do You Run CAD/BIM in the Cloud?
No, and we never will 11%
No, the technology needs to improve 14%
No, unless company policies change 37%
Yes, on a limited number of projects 17%
Yes, we are currently evaluating 11%
Yes, we use it regularly 9%

0 5 10 15 20 25 30 35 40

How Did You Find Your Current Job?
Word of mouth/personal referral 44%
Advertisement 21%
Recruiter 14%
Contacted company to inquire about openings 11%
Promotion 6%
Owner (Created Company) 4%

0 10 20 30 40 50

Has Your Salary Changed in the Past Year?
Decreased 3%
No Change 24%
Increased 1 - 2% 27%
Increased 3 - 4% 23%
Increased 5 - 7% 10%
Increased 8 - 10% 6%
Increased 11 - 15% 3%
Increased more than 15% 5%

0 5 10 15 20 25 30

(If applicable) What Percentage of Your 
Company’s Projects Are BIM?
1 - 25% 22%
26 - 50% 10%
More than half 21%
All 13%
None 25%
Unsure 9%

0 5 10 15 20 25

The average pay for firms that do 
more than half of their applicable 
projects in BIM is 5% higher than 
those who use it on less than a quar-
ter of their projects.
Today, 25% of applicable companies 
are not using BIM, down from 36% 
when we first asked this question 
in 2012.
In 2007, 1.6% of respondents were 
BIM Managers; that number is 9% to-
day, plus the 4% of respondents who 
are BIM Coordinators.

The fields paying out the largest 
raises this year were Construction, 
Architecture, and Electronics.
The positions receiving the highest 
pay increases this year were Pro-
grammers and BIM Managers.
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DESIGNER CLOSE-UP

Designer Education Levels
Associates Degree (2 years) 43%
Bachelors Degree (4-5 years) 22%
Technical/Vocational 19%
Masters 8%
High School/GED 8%

0 10 20 30 40 50

Average Designer Salary
Overall  $64,687
Male  $65,357
Female  $61,529

0 10 20 30 40 50 60 70 80

0 20 40 60 80 100

Petroleum/Gas/Biofuels $87,132 
Facility Management $70,466 
Structural $61,608 
Electronics $61,922 
Landscape Design/Architecture $45,167 
Civil/Survey/GIS $65,484 
Construction $69,356 
MEP/FP $63,762 
Manufacturing $61,038 
Architecture $57,570 
Education/Training $56,889 
Interior Design $59,802 
Sales / Marketing $49,462

Average AUGI Designer Salary by Industry

Designers have spent an average of 
8 years working with their current 
company.

62% of Designers can work flexible 
hours.

22% of Designers report the ability to 
telecommute.

44% of Designers rate their workload 
as Extremely Busy, which is an in-
crease from last year.

2003 $44,686
2005 $49,710
2007 $52,639
2009 $55,345
2011 $57,831
2013 $59,613
2015 $62,775
2017 $64,687

Average Designer Pay

0 10 20 30 40 50 60 70 80

Average Age of Designers is 43.

Decreased 4%
No Change 22%
1-2% increase 29%
3-4% increase 24%
5-7% increase 9%
8-10% increase 6%
11-15% increase 2%
>15% increase 4%

Change in Salary

0 5 10 15 20 25 30

Average designer has 18 years of 
experience in the industry.

Employment Change in the Past Year
Same Job 74%
Reduced Hours 1%
Increased Hours 9%
New Job, Same Company 3%
New Job, New Company 9%
Laid Off 3%

0 10 20 30 40 50 60 70 80

76% of Designers feel secure in their 
jobs, this is down slightly (3%) from 
last year.

http://www.augiworld.com
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A LOOK BACK

Percentage of Gender Pay Difference
2005 10.3%
2007 11.5%
2009 10.0%
2011 9.2%
2013 11.5%
2015 10.0%
2017 7.0%

0 2 4 6 8 10 12
* these numbers reflect a 40 hour work week

Percentage of Respondents Who Received 
No Raise
2002 28%
2004 28%
2006 20%
2008 19%
2010 39%
2012 30%
2014 25%
2016 28%
2017 27%

0 5 10 15 20 25 30 35 40

Melanie Perry is a CAFM Solutions 
Architect with InfoNarus. She is 
a past AUGI Director/Officer 
and is currently involved with the 
STLRUG. Melanie can be reached at 
mistressofthedorkness@gmail.com or 
found on Twitter as @MistresDorkness

*this question was not asked every year

Percentage Reporting Poor Workload*
2011 36%
2015  19%
2016  20%
2017  16%

0 5 10 15 20 25 30 35 40

Users Who Experienced a Decrease in Pay
2006 3%
2007 2%
2008 3%
2009 15%
2010 16%
2011 8%
2012 7%
2013 6%
2014 5%
2015 4%
2016 4%
2017 3%

0 5 10 15 20

Percentage of Users Who Feel Secure

2007 86%
2009 73%
2011 75%
2013 74%
2015 80%
2017 78%

0 20 40 60 80 100

Percent of Users Who Are Satisfied
2007 79%
2009 77%
2011 71%
2013 69%
2015 71%
2017 70%

0 10 20 30 40 50 60 70 80

Since 2013, we have been polling our 
members about whether or not they 
leave work at work, or their avail-
ability after hours. Surprisingly, after 
hours availability has decreased 3%.

mailto:mistressofthedorkness%40gmail.com?subject=
https://twitter.com/MistresDorkness?lang=en


AUGI 
Members 
Reach Higher 
with Expanded 
Benefits
AUGI is introducing three new Membership levels 
that will bring you more benefits than ever before. 
Each level will bring you more content and expertise 
to share with fellow members, plus provide an 
expanded, more interactive website, publication 
access, and much more! 

MEMBER

MEMBER

MEMBER

MEMBER

MEMBER

MEMBER

MEMBER

MEMBER

MEMBER

Basic members have  
access to:
•	Forums
•	HotNews (last 12 months)
•	AUGIWorld (last 12 months)

DUES: Free

Premier members have  
access to:
•	Forums
•	HotNews (last 24 months)
•	AUGIWorld (last 24 months)

DUES: $25

Professional members have  
access to:
•	Forums
•	HotNews (full access)
•	AUGIWorld  
 (full access and in print)
•	ADN	2013	Standard 
 Membership Offer

DUES: $100

Are you ready to upgrade yourself and your membership? 
Access additional benefits and upgrade at www.augi.com



FIND OUT MORE

WWW.BOXX.COM/VCA
888-302-0223

Accelerate your design and production workflow 
like never before with the VCA-certified BOXX 
APEXX 8R. Built for enterprise-class content 
creators, APEXX 8R delivers the finest NVIDIA® 
Quadro® has to offer—GPU-accelerated 
performance for selected renders, along with 
expandability, unparalleled performance, and 
mobility within your deployment.

GPU-Accelerated
Rendering.
VCA Certified.

http://www.boxx.com/vca

